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Installing KNIME Analytics Platform


For step-by-step videos on how to install KNIME Analytics Platform, please take

a look at our KNIMETV YouTube channel.

1. Go to the download page on the KNIME.com website to start installing KNIME Analytics

Platform.

2. The download page shows three tabs which can be opened individually:

◦ Register for Help and Updates: here you can optionally provide some personal

information and sign up to our mailing list to receive the latest KNIME news

◦ Download KNIME: this is where you can download the software

◦ Getting Started: this tab gives you information and links about what you can do

after you have installed KNIME Analytics Platform

3. Now open the Download KNIME tab and click the installation option that fits your

operating system. KNIME Analytics Platform can be installed on Windows, Linux, or

macOS.

Notes on the different options for Windows:

◦ The Windows installer extracts the compressed installation folder, adds an icon to

your desktop, and suggests suitable memory settings.

◦ The self-extracting archive simply creates a folder containing the KNIME

installation files. You don’t need any software to manage archiving.

◦ The zip archive can be downloaded, saved, and extracted in your preferred

location on a system to which you have full access rights.
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Figure 1. KNIME Analytics Platform versions

4. Read and accept the privacy policy and terms and conditions. Then click Download.

5. Once downloaded, proceed with installing KNIME Analytics Platform:

◦ Windows: Run the downloaded installer or self-extracting archive. If you have

chosen to download the zip archive instead, unpack it to a location of your choice.

Run knime.exe to start KNIME Analytics Platform.

◦ Linux: Extract the downloaded tarball to a location of your choice. Run the knime

executable to start KNIME Analytics Platform.

◦ Mac: Double click the downloaded dmg file and wait for the verification to finish.

Then move the KNIME icon to Applications. Double click the KNIME icon in the list

of applications to launch KNIME Analytics Platform.

 Also check the KNIME Getting Started Guide and the KNIME Workbench Guide.

Configuration settings and knime.ini file

When installing KNIME Analytics Platform, configuration settings are set to their defaults,

and they can later be changed in the knime.ini file. The configuration settings, i.e. options

used by the Java Virtual Machine when KNIME Analytics Platform is launched, range from

memory settings to system properties required by some extensions.

You can find knime.ini in the installation folder of KNIME Analytics Platform.
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

On MacOS: To locate knime.ini on MacOS, open Finder and navigate to your

installed Applications. Next, right click the KNIME application, select Show

Package Contents in the menu, and navigate to Contents → Eclipse.

The knime.ini file can be edited with any plaintext editor, such as Notepad (Windows),

TextEdit (MacOS) or gedit (Linux).

Allocating memory in knime.ini file

The entry -Xmx1024m in the knime.ini file specifies how much memory KNIME Analytics

Platform is allowed to use. The setting for this value will depend on how much memory is

available in your machine. KNIME recommends setting it to approximately one half of your

available memory, but you can modify the value based on your needs. For example, if your

computer has 16 GB of memory, you might set the entry to -Xmx8192m.
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Installing Extensions and Integrations

If you want to add capabilities to KNIME Analytics Platform, you can install extensions and

integrations. The available extensions range from free open source extensions and

integrations provided by KNIME to free extensions contributed by the community and

commercial extensions including novel technology nodes provided by our partners.

The KNIME extensions and integrations developed and maintained by KNIME contain deep

learning algorithms provided by Keras, high performance machine learning provided by H2O,

big data processing provided by Apache Spark, and scripting provided by Python and R, just

to mention a few.

Install extensions from:

• KNIME Hub:

◦ Search for the Extension or Integration you want to install in the search bar

◦ Click Extensions on the results page

◦ Click the extension you want to install, and from the extension page and drag and

drop the squared yellow icon, shown in Figure 2, to the workbench of KNIME

Analytics Platform. A window will open asking if you want to search and install

the extension or integration. Click Yes and follow the instructions.

Figure 2. Install the KNIME Integrated Deployment Extension from KNIME Hub

◦ Restart KNIME Analytics Platform.

• KNIME Analytics Platform:

◦ Click File on the menu bar and then Install KNIME Extensions…. The dialog shown

in Figure 3 opens.
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Figure 3. Installing Extensions and Integrations from KNIME Analytics Platform

◦ Select the extensions you want to install

◦ Click Next and follow the instructions

◦ Restart KNIME Analytics Platform.

The Install KNIME Extensions menu provides the extensions that are available via the update

sites you have enabled.


For more information, take a look at our video on How to Install Extensions in

KNIME Analytics Platform. Also see the Extensions and Integrations Guide.

To uninstall an extension, click Help, About KNIME Analytics Platform, and then Installation

Details. A dialog shown in Figure 4 opens. Now, select the extension that you want to

uninstall, and click Uninstall….
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Figure 4. Uninstalling Extensions and Integrations

KNIME Analytics Platform Installation Guide

© 2021 KNIME AG. All rights reserved. 6



Updating KNIME Analytics Platform and
Extensions

It is good to make sure that you always use the latest version of KNIME Analytics Platform

and its extensions.

Do this by:

1. Clicking File → Update KNIME…. In the dialog that opens, select the available updates

you want to install and then click Next.

2. Proceed by following the instructions. KNIME Analytics Platform has to be restarted in

order to apply the updates.
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Update Sites

The Update Sites are where KNIME retrieves additional software in the form of extensions as

well as updates. To see or edit the available update sites, select File → Preferences →
Install/Update → Available Software Sites.

Default Update Sites

These four updates sites are provided by KNIME and are always available:

Figure 5. Available Update Sites

KNIME Analytics Platform 4.4 Update

Site: Provides all extensions and

integrations maintained by KNIME: R,

Python, H2O Machine Learning, Apache

Spark for big data, and many more.

Contains KNIME Labs Extensions, which

are extensions that are not yet part of the

set of stable KNIME extensions because

their functionality may not yet be

finalized.

KNIME Community Extensions (Trusted):

Provides trusted community extensions,

i.e. extensions created by the KNIME

community, which have been tested for

backward compatibility and compliance

with KNIME quality standards.

KNIME Partner Extensions: Provides

extensions created by KNIME partners.

Community Extensions (Experimental):

Provides additional extensions created by

the KNIME community.

KNIME Analytics Platform 4.4 Update Site and KNIME Community Extensions (Trusted) are

enabled by default.
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Adding External Update Sites

To install extensions that are not part of the above update sites, click Add to manually add

the relevant update site, inserting the Name and Location as shown in Figure 6.

Figure 6. Add Update Sites

After adding a new update site you will see it listed in the Available Software Sites. You must

now enable it by selecting it from the list.

Adding Local Update Sites

If your working environment has limited internet access or you receive an error message

“Proxy Authentication Required” when connecting to a remote update site (provided by a

URL), you can install extensions from a local zip file.

1. Download KNIME update sites as zip files at the following links:

◦ KNIME Analytics Platform Update Site

◦ KNIME Community Extensions

◦ KNIME Partner Extensions

2. Save the zip file containing the extensions to your local system

3. Select File → Preferences → Install/Update → Available Software Sites and enter the

path to the zip file by clicking Add → Archive… as shown in Figure 7.
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Figure 7. Adding Update Sites from Zip Archive


If the same extensions are provided by a URL, you will first have to disable

the update site by disabling it in the list.

4. Now click Apply and Close



If the same extensions are also provided by a remote update site, you will

first have to disable that update site by deselecting its entry in the

Available Software Sites dialog and confirming via Apply and Close.
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Working with the Nightly Builds

Once a night, a new version of KNIME Analytics Platform is created directly from our

development branch. The Nightly Build versions available here provide insight into what’s

coming up in the next regular release. However, for real work, always use a version of a

standard KNIME release. Also read the following disclaimer before proceeding:



Really, really, really important disclaimer

This is most definitely not production quality code. These nightly builds are

what we use internally to validate and test recent developments, so they are not

tested as thoroughly as standard KNIME releases. Furthermore new nodes or

functionality may change substantially (or disappear entirely) from one build to

the next. It’s even possible that workflows you edit or create with nightly builds

stop being readable by future (or past) versions…

These nightlies are a great way to get a sneak peek at what may be coming in

the next version of KNIME and provide feedback and suggestions. They are not

a particularly safe way to do real work.
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Changelog (KNIME Analytics Platform 4.4)

Detailed changelog for v4.4.x releases

KNIME Analytics Platform 4.4.0

(see highlight summary)

Release date: June 30, 2021

New nodes

• AP-17077: MongoDB Connector (multiple new nodes, extension rewritten)

• AP-10494: Snowflake Connector

• AP-15952: Refresh Button Widget (for Dynamic Data Apps)

• AP-13331: Workflow Reader

• AP-16816: Workflow Summary Extractor

• AP-3325: Variable Creator

• AP-12355: Container Input (File)

• AP-10537: H2O Integration: H2O AutoML Learner

• AP-16680: Container Input (Variable) (revised)

• AP-16669: Container Output (File)

• AP-16612: DB Table Creator with new table selection component

• AP-16808: JSON Reader (new file handling)

• AP-16567: File Reader (new file handling)

• AP-16566: File Reader (Complex Format)

• AP-15932: Compress Files/Folder table input (new file handling)

• AP-14932: Transfer files table input (new file handling)

• AP-13864: Image Writer (Table) (new file handling)

• AP-13418: Table Writer (new file handling)

• AP-13414: Table Reader (new file handling)
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Enhancements

• AP-15826: Upgrade to Java 11 and Eclipse 2021-03

• AP-17014: Cleanup Preference Pages and Wizards

• AP-16967: Keep original exceptions as cause in

KafkaConnectionValidator.java#checkConnection

• AP-16946: Node Repository: Move Conda folder up from Python to Scripts folder

• AP-16940: Enable R nodes to directly use conda.environment flow variables

• AP-16843: Amazon S3 Connector: Add SSE-C support

• AP-16842: Add timeout option(s) to "Send to Tableau Server" node

• AP-16779: Rename node category and change node description … of 'Single Page

Application'.

• AP-16718: Update buillt-in mysql5 driver to version 5.1.49 to support TLS 1.2

• AP-16712: Chromium update to version 91

• AP-16701: Update Jackson to 2.12.1

• AP-16662: Show only selected data on start scatter plot

• AP-16659: Support custom client id and secret in Google Authentication node

• AP-16605: Additional date and time functions for Column Expression node

• AP-16556: Table Validator with new option to validate only on execution (needed in Try-

Catch constructs)

• AP-16539: Arrow: Unmap MappedByteBuffer when they are not needed anymore

• AP-16516: Metadata support for databases without schemas e.g. Firebird

• AP-16482: JS View Image Generation using CEF

• AP-16448: Integrated Deployment: Capture Start/End node with new option to

propagate 'scope' variables

• AP-16447: Try-Catch node with new option to propagate 'scope' variables

• AP-16446: Loops with new option to feed back modified variables to their loop start

nodes

• AP-16440: Support Path type in Column Expressions node

• AP-16433: Java Snippet to support Java 11 language feature

• AP-16365: Return missing values if FS does not support permission look ups

• AP-16267: Add single page re-execution in the AP for the CEF
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• AP-16180: Always allow String as KNIME type in transformation tab of Parquet/ORC

Reader

• AP-16067: Expose file size, creation and modify date for KNIME Server file system

• AP-16030: Always allow String as KNIME type in transformation tab of Excel Reader

• AP-16028: Allow to set the KNIME type of unknown columns in transformation tab of

reader nodes

• AP-16027: Always allow String as KNIME type in transformation tab of CSV Reader

• AP-15971: Update H2O to 3.32.1.2

• AP-15884: Show Nodefactory class in Nodemonitor

• AP-15876: Allow merging of different FSLocationCells

• AP-15871: More Java to KNIME Converters for Numeric Values

• AP-15808: Add executable selection tab to all Python nodes

• AP-15802: Name of conda env flow variable should be user-defined

• AP-15387: Enable compression in Apache Arrow Backend

• AP-15202: User defined Hub view

• AP-15123: Append File Rights Attributes to Files/Folders Meta Info (new filehandling)

• AP-15078: Integrated Deployment: String representation of a workflow should be its

custom workflow name if set

• AP-15006: Send to Tableau: Add option to authenticate with "Personal Access Token"

• AP-14999: Joiner node to be able to match different column types

• AP-14778: GET Request node to support query retry with delay

• AP-14724: UI Improvement “Workflow Combiner”

• AP-14723: Small UI Improvement “Capture Workflow End”

• AP-14577: Join with Match Any

• AP-14401: Revised help menu

• AP-14326: Power-BI: Allow for Table Relationships

• AP-14006: Add OS agnostic line break option to csv reader

• AP-13961: Support reading of password protected Excel files

• AP-13949: Create option in reader nodes to add file identifier when reading multiple

files without loop

• AP-13933: Support multi database in db nodes
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• AP-13899: Support multiple projects when working with BigQuery

• AP-13049: Add success message after successfull deployment of preferences

• AP-12193: DB Loader support for Snowflake

• AP-8195: Change line thickness in Java Script based line plot

• AP-7397: REST nodes should have an option to disable chunked transfers

• AP-5213: "Run only during execute" in Java Edit Variable node is confusing

• BD-1117: (Big Data Extensions): Add support for Spark 3.0 to KNIME Livy client

• BD-1103: (Big Data Extensions): Update Create Local Big Data Environment to Spark

3.0.2

• BD-1102: (Big Data Extensions): Add support for Spark 3.0 to KNIME Extension for

Apache Spark

Bug Fixes

• AP-16763: Layout and Configuration Editor is not working on Linux (due to some lib

changes on the OS level)

• AP-16730: Table to PDF & HTML cannot write pngs

• AP-16486: External NPM version dependencies cause IE11 to fail

• AP-16040: Twitter Streaming node failure

• AP-17061: Test Data Generator fails with only a few rows using fast tables

• AP-17059: Boolean Sets with only a few rows cause unsafe memory access in fast

tables

• AP-17031: Bundle org.knime.ext.ftp.filehandling fails to initialize

• AP-16950: Active Learner Loop Start/End nodes cause NPE / error dialog in case

"favorite nodes" view is open

• AP-16943: Chrome Driver fails to render images on output ports on Windows

• AP-16939: Workflow Reader: Incorrect node message when no workflow is specified

• AP-16903: Move file name column to the end rather than prepending it in reader nodes

• AP-16888: DB Loader loads wrong values for boolean columns in MySQL

• AP-16887: NullPointerException in Call Local Workflow (row based) node when report

is generated

• AP-16880: Excel Reader cannot handle numeric cells with missing values but without

cell type
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• AP-16875: Improve loading indicator – Define a max-height for the loading indicator

• AP-16844: SSH Connector: Fix file attribute cache issues after copy/move

• AP-16827: The transformation tab resets the column order when the dialog is reopened

• AP-16825: DynamoDB nodes lose rows when table spec changes in-between read

batches

• AP-16824: FTP Connector cannot browse or list files on Windows IIS FTP server

• AP-16813: NPE in Parameter Optimization Loop Start

• AP-16807: Annotation text on Linux sometimes not readable (font not installed)

• AP-16783: Path to URI with presigned URLs should use normalize

• AP-16774: Extract system properties exports application-wide ('static') proxy

passwords in cleartext

• AP-16768: NullPointerException in Files/Folders Meta/Info node on paths from SSH

Connector

• AP-16761: Add better error message for SPA not working in Bundled Chromium and

SWT Browser

• AP-16734: Workflow Writer / Deploy to Server nodes do not work if the server URL

contains a port and contains a trailing slash

• AP-16697: Fix different behavior of Clock.systemDefaultZone().instant()

• AP-16682: Community converter can overwrite KNIME converter

• AP-16660: Make WordWrapJLabel a fixed size label

• AP-16643: MacOS Big Sur: Various screen artifacts (distorted table, broken splash

screen, etc…)

• AP-16627: Context menus of components linking to a disconnected Hub space cannot

be opened

• AP-16585: Conda Environment Propagation Dialog forever loads if Python is not set up

• AP-16580: Fix Locales for extract date & time

• AP-16570: Python: File extension mapping of pickled files (.pkl) maps to deprecated

Python Object Reader node

• AP-16549: Workflow executor fails if directly connected to workflow input port (i.e. in a

metanode)

• AP-16538: "Workflow Executor" exports variables in reverse order

• AP-16488: Race condition (and memory leak) when data is retrieved and evicted from

the cache at the same time
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• AP-16471: Google nodes that use the Google Authentication output port sometimes fail

with "Unable to clone input data at port"

• AP-16456: Create Temp Dir throws NPE for Relative to FS after workflow is closed

• AP-16395: DB Transaction End node shouldn’t fail with inactive input ports

• AP-16289: Conda Environment Propagation: Kernel queue is not cleared upon failure

during environment creation

• AP-16214: Python: Deprecated port type selectable in component setup

• AP-16211: NodeSettingsMigrationManager#getSourceVariableSettings returns

destination variable settings instead

• AP-16160: NPE when closing the Workflow Coach

• AP-16124: Column selection set to "Document" instead of "Preprocessed Document" in

workflow example

• AP-16110: Mountpoint file system cannot connect to server workflow repository when

running workflow on KNIME Server

• AP-16062: Add data to Reference Reader nodes recursively (for workflow ports)

• AP-16054: Domain Calculator throws exception if Path column is included

• AP-15972: KNIME Server Connector and Relative to file systems treat workflows

differently

• AP-15969: NPE on DnD of an URI lacking a host

• AP-15886: Installing extension not on update sites throws NPE

• AP-15882: Problem with connections reaching into a capture scope whose source is

the parent workflow (i.e. metanode port)

• AP-15879: Fix virtual scope context retrieval from metanode

• AP-15877: Parallel Chunk Loop should retain port objects which lead into a capture

scope for later usage

• AP-15862: TRF based Readers don’t recalculate the spec if spec affecting settings are

controlled via flow variable

• AP-15722: Wrapping/scrolling of status message doesn’t work properly

• AP-15623: FileReader throws wrong exception text

• AP-15431: SettingsModelReader/Writer show filter options though they are not

available

• AP-15066: Workflow Writer displays confusing warning on escaped default workflow

name
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• AP-15030: 'Search'-menu entry in main menu (should be removed)

• AP-14672: Text Output Widget internals not reset consistently with other nodes

• AP-14627: TensorFlow 2 Reader: Reading a network in SavedModel format from

TensorFlow Hub fails with ProviderMismatchException

• AP-14554: Check if “Custom workflow name” in ”Capture Workflow End“ node has

illegal characters

• AP-13893: Problem with credentials flow variables when injected via reference reader

node

• AP-13769: Configure in Joiner slow for wide tables

• AP-13500: Handle missing port object types when loading workflow segments

• AP-13171: Send to Power BI node: Upload with special column name fails

• WEBP-779: Progress reset on refresh for Data-Apps — Include full set of re-executed

node IDs in addition to the re-executing node IDs

KNIME Analytics Platform 4.4.1

Release date: August 25, 2021

New nodes

• AP-17218: XML Reader (new file handling)

• AP-13421: JSON Writer (new file handling)

• AP-13420: XML Writer (new file handling)

• BD-1116: (Big Data Extensions): Spark Logistic Regression Learner (based on spark.ml)

• BD-1115: (Big Data Extensions): Spark Linear Regression Learner (based on spark.ml)

Enhancements

• AP-16893: SVM Learner: Better error message when target column contains constant

value

• AP-16540: SAP Reader (Theobald Software) with support for Kerberos authentication
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Bug Fixes

• AP-17355: Save As button sometimes disabled (but shouldn’t)

• AP-17348: Problems deserializing AdapterCells containing blobs after restoring

workflow

• AP-17317: Amazon S3 Connection (legacy) throws NoClassDefFoundError

• AP-17301: Path To String and Path To String (Variable) nodes do not work with

workflow-relative paths if executed on KNIME Server

• AP-17259: External Tool node Error / Output View does not work anymore in 4.4.0

• AP-17253: Windows: KNIME 4.4. up to 30% slower than KNIME 4.3 (not using "server"

VM)

• AP-17250: Arrow Python serializer fails with environments created by preference page

on Windows

• AP-17243: JSON To XML Node generates an invalid XML

• AP-17210: Component views only work for top-level components

• AP-17201: Reader and writer node dialogs do not open in RWE anymore

• AP-17160: Drag and drop of shortlinks from workflows etc. not working anymore

• AP-17158: Dialog of Create Date&Time Range node cannot be closed

• AP-17126: Fix Metadata Browser on database connections without multi DB support

• AP-17102: Workbench focus lost when configuring node

• AP-17371: Parquet Reader and Writer fail with SMB Connector

• AP-17370: FTP Connector: Unable to list directory if it’s name contains spaces

• AP-17369: FTP Connector: concurrency issue with the createDirectory method

• AP-17368: FTP Connector: "Execute failed: 150" error when running Table Reader node

• AP-17367: FTP Connector: OutputStream is extremely slow

• AP-17330: Deep learning: Installation tests do not use variable-controlled Python

environment

• AP-17295: AP can’t extract creation date from workflow

• AP-17230: NPE in Decision Tree to Ruleset if tree contains only the root node

• AP-17206: File Reader node description should refer to the Complex File Reader

• AP-17183: Python Object Writer has wrong default script

• AP-17155: Double Widget node overrides user input in scientific notation when

lowercase 'e' is used
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• AP-17152: Filter event fired on re-load after re-execution (Refresh Button) event does

not contain filter information

• AP-17146: Typo: "Specifiy" in the Setup Component Wizard

• AP-17128: Deep learning conda environments specified via executor.epf are ignored

• AP-17108: No Focus on dialog when opening node configuration

• AP-17078: Closing and saving a workflow sometimes throws NPE

• AP-17021: MultiLayerPerceptron Predictor node: Node configuration is not in sync with

node description

• AP-16977: Simple Streaming Executor can not handle inactive ports

• AP-16961: File Chooser Widget node leads to following error when clicking the refresh

button

• AP-16872: Node view values not updated on config- or input-spec-change

• AP-16723: Default configuration of Strings to Document node can lead to NPE errors

• AP-16688: Conda Env Prop node needs to clean up after itself when conda env re-

creation fails

• AP-16565: Python: Dialog panes of scripting nodes throw

NullPointerException/IndexOutOfBoundsException

• AP-16333: Double Configuration node overrides user input in scientific notation if

lowercase 'e' is used

• AP-16299: Credentials Widget does not save KNIME Server Login

• AP-15951: Opening workflow with “External Tool” node with invalid dialog settings

causes errors even if configured using flow variable

• AP-15664: Keras: Unmaterialized port object does not use variable-controlled Python

environment

• AP-15366: Component on server can’t be overwritten from KNIME Explorer

• AP-13732: Keras: LSTM layers cause OpenMP Error #15 (Mac only)

• WEBP-824: Downstream metanodes prevent re-execution of single page

KNIME Analytics Platform 4.4.2

Release date: October 21, 2021
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Bug Fixes

• AP-17454: XPath node fails to parse XML documents with more than 2000 lines on

non-English locale

• AP-17443: Deeply Nested Components won’t show views

• AP-17416: DB metadata browser should expand only first hierarchy level

• AP-17403: Call workflow table-based does not recognise Container input variable

• AP-17630: Dragging and dropping XML files to a workflow calls deprecated XML

Reader

• AP-17544: JSON/XML/Image Writer node dialog does not detect port-based file system

connection

• AP-17520: DB functions starting with $ can make KNIME unresponsive

• AP-17484: Microsoft Authentication node claims success but does not provide

authentication

• AP-17470: Excel Reader only hides first column in a group of consecutive hidden

columns when reading XLSB files

• AP-17461: Refresh button deactivates interactive filters widget

• AP-17456: SAP Reader (Theobald Software) fails when reading missing date and time

fields

• AP-17438: Excel Reader shifts data if column on the left of a hidden column contains

missing values

• AP-17430: Call Workflow (Table Based) node doesn’t delete jobs after configure

• AP-17425: Fix "Include only explicitly installed" button of Conda Env Prop node on

target machine

• AP-17407: Table Row to Variable node no longer able to handle columns of missing

type

• AP-17362: Widgets: flow variable-controlled configs are not transferred to view value on

re-execution

• AP-17234: Workflow Writer fails on opening written workflow if Explorer is not

initialised

• AP-17172: Typo in Workflow Editor Settings

• AP-17003: Non-deterministic output in String Manipulation Multi Column Node

• AP-16812: File Upload Widget does not percent-encode illegal characters in knime://

URLs
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• AP-16741: Cannot update mountpoint-relative components when opening workflow

from server as local copy

• AP-16740: Memory leak when hiliting is enabled leads to executors running out of heap

space

• AP-16066: Heatmaps in the Same Component Plot the same Columns

• AP-13839: Number to String and String to Number check included columns, even if

exclude list is enforced

KNIME Analytics Platform 4.4.4

Release date: January 19, 2022

(includes changes of 4.4.3, which was not released publicly)

Bug Fixes

• AP-18100: Generic Web Services Client fails on certain WSDLs with the 4.4 update

• AP-17734: Date&Time Widget: flow variable takes presence over manually changed

values

• AP-17729: FlowObjectStack not properly updated on configure under special

circumstances

• AP-17717: Credentials Widget does not work with the refresh button without a default

value set

• BD-1154: (Big Data Extensions): Metadata browsing fails with Local Big Data

Environment database

• AP-18232: Excel Writer fails to append to existing file using SMB Connector

• AP-18227: NPE in NodeContainerEditPart on Component Update

• AP-18211: XML Reader leaks input streams when using XPath with invalid reader

settings

• AP-18196: Update log4j version used by xmlbeans to 2.17.1; prevents CVE-2021-44228

and others (though not exploitable in KNIME)

• AP-18126: Custom/KNIME URL file system does not properly handle HTTP responses

with compressed Content-Encoding

• AP-18121: Index Reader node does not use connected file system

• AP-17693: Tableau: Error when writing hyperlog on Server
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• AP-17576: Refresh Button Widget: Activated view / widget nodes not defined in the

layout are missing after refresh button execution

• AP-17559: Excel Writer fails when writing to XLSX with Evaluate Formulas option

enabled

• AP-17469: Refresh Button Widget causes String Widget to complain about an empty

input

• AP-17457: Send to Power BI: Fix NPE if Power BI sends an unexpected error

• AP-17365: Filtered columns are still considered as duplicate column names

• AP-17072: Salesforce Simple Query node does not properly URLencode the where

clause

• AP-15679: Weird Prompt comes up in New File Handling framework

• BD-1153: (Big Data Extensions): PySpark: Invalid Python code inserted when clicking on

input column

• BD-1150: (Big Data Extensions): Databricks File System Connector/Create Databricks

Environment nodes should handle HTTP 401 response on invalid credentials
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